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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2007 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

For additional trademark information, see the Chapter 8, “Copyright,” in the HP OpenView Enterprise 
Discovery Reference Guide.  
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Support 

You can visit the HP Software Support web site at: 

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.   

To find more information about access levels and HP Passport, go to: 

http://support.openview.hp.com/new_access_levels.jsp
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Release Notes 
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This document provides an overview of the changes made to Enterprise Discovery for version 2.20. It 
contains important information not included in the manuals or in the online help. 
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Obsolete Features

Documentation Updates

Installation Notes
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.20. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.1.x and 2.0.x. In this release, Enterprise discovery has 
changed it versioning notation to match HP standards. 

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.0, 2.0.1, 2.0.2, 2.0.3, 2.0.4, 2.1, 2.1.1, and 2.1.2), you can read the Release Notes for 
those versions, available on your installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data from a maximum of 50,000 inventoried devices and 60,000 
devices in total. The port limit is 150,000 ports (whichever comes first). An Enterprise Discovery Aggregator 
can support 50 servers and up to 500,000 devices. 

The new Automated Inventory license enables you to purchase inventory capability based on the number of 
devices that you expect to manage. This license replaces the Device Discovery and Device Inventory licenses 
provided in previous versions of Enterprise Discovery. If you have purchased these two licenses for a 
previous version, you will have access to all features provided with the Automated Inventory license offered 
with version 2.20. Note that the Automated Inventory license is functional but is not yet reflected in the 
Enterprise Discovery user interface. 

Updated third party components 

• Sun Java Runtime Environment (JRE) 1.5.0_10 

• MySQL Enterprise 5.0.36 
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New Features  
The following features are available in this version of Enterprise Discovery: 

Support for Solaris Zones 

Enterprise Discovery now shows how the Solaris server is being used. The Solaris zones are linked to the 
host server. Each zone can be treated as a separate device. It is possible to discover, scan for hardware and 
software assets, and collect software utilization data on the host Solaris machine and each of its zones. 
Enterprise Discovery can determine the parent/child relationship between the physical host device and the 
virtual devices (zones) hosted on the physical device. As such, you are able to see the host/virtual device 
information in the Virtual Devices Window, the Device Manager, and the Virtual Device Reports. Refer to 
the “Virtualization and Enterprise Discovery” chapter in the Reference Manual. 

Enhanced Support for VMware Environments  

Enterprise Discovery now maps VMware images to the host VMware ESX server 3.0 or higher. You can see 
how virtual machines (VMs) are being used in your network environment. Since Enterprise Discovery can 
determine the parent/child relationship, VMs are linked to their physical host machines, but each VM is 
treated as a separate device with respect to discovery, hardware scanning, and software utilization. You are 
able to see the host/virtual device information in the Virtual Devices Window, the Device Manager, and the 
Virtual Device Reports. Refer to the “Virtualization and Enterprise Discovery” chapter in the Reference 
Manual. 

New and Improved Discovery Configuration 

A new configuration process with a more intuitive navigational flow and modern look-and-feel is provided. 
This new process and user interface make it easier to manage discovered devices in the following ways: 

• Configuration properties can be associated with devices based on device type—for  example, servers or 
workstations—not just IP addresses. 

• Your configuration is kept up-to-date automatically with the latest device information. 

• You have more control over and visibility into the configuration process. 

In earlier versions of Enterprise Discovery, the only way to group network devices was by using IP ranges. 
Devices in the same IP range shared the same set of properties. This was inconvenient, because an IP range 
could encompass devices with completely different functionality. A network switch and a printer, for 
example, would be grouped together.  

Refer to the “Configuring the Discovery Process” chapter in the Installation and Initial Setup Guide, as well 
as the Discovery Configuration online help, for more information. 

Software Utilization Data Collection on all Platforms 

Support is extended to non-Windows platforms to collect software usage information. Coverage includes all 
platforms that are supported for inventory. This affords valuable information about software utilization and 
licensing optimization on all Enterprise Discovery managed computers in the enterprise. 
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Enhanced Support for Windows Vista 

You can now perform inventory scanning and collect software utilization data on devices running the 
Microsoft Windows Vista operating system. In addition, Microsoft Windows Vista Readiness reports are 
available. These reports enable you to quickly see which scanned devices in your network environment meet 
the business system requirements for Windows Vista, and which do not.  

To determine the Windows Vista readiness level for each scanned device, Enterprise Discovery examines six 
components: CPU type and speed, total memory, total and free disk space, graphics display card features 
and memory size, audio output capability, and the presence of an optical (CD or DVD) drive. A readiness 
level is reported for each component, and an overall readiness level for the system is reported. A summary 
report that shows the percentage of scanned Windows workstations and servers in your network that are 
ready for Vista is also provided. 
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Compatibility Note 
In an aggregated environment, the Aggregate server and the remote servers do not need to be running the 
same version of Enterprise Discovery. An Enterprise Discovery 2.20 server can aggregate Enterprise 
Discovery 2.1.x servers, but the following links in the left navigation panel on the remote server will not be 
available: 

• Asset Questionnaire 

• Administration > Network Configuration 
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Obsolete Features 
Support for automatic agent deployment through the listener agent used with the Peregrine Network 
Discovery product has been removed from this release of Enterprise Discovery. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name (for example, Enterprise Discovery). 

2 In the Version list, click the version number. 

3 In the OS list, click the operating system type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

• Migrating from Network Discovery 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 
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Installation Notes 
Installation requirements, as well as instructions for installing Enterprise Discovery, are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery.   

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

4 Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.0.x: C:\Program Files\Peregrine\Enterprise Discovery\2.0.* 
 
Version 2.1.x: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

5 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

6 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server, Service Pack 1 or Service Pack 2. 
The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB under Program Files 
for the Enterprise Discovery installation. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A

gg
re

ga
ti

on
 

A
u

to
m

at
ed

 
In

ve
n

to
ry

 

T
op

ol
og

y 

Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x 3 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  2** 
2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000 
 

x x 7 
2+ CPUs or cores 
3.6 GHz 260 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

* CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP Enterprise Discovery is a multi-threaded application, and 
benefits from Simultaneous Multi-Threading (SMT) technologies such as Intel® Hyper-Threading. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs and more memory may be required. 
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These calculations have been tested as scenarios for maximum disk size on the server. For the Inventory 
license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

• For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, or 2003 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

5.0 or 6.0 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in the current software 
release. Table 2 lists enhancements to existing features or behavior; Table 3 lists problems that were fixed. 

Table 2 – Enhancements 

Number Location Enhancement Description 

14545 Administration > 
Discovery Configuration 

The “Scanner upgrade schedule” option from the 
Scanner property group in the old Network 
Configuration has been renamed to 
“Deploy/upgrade scanners using this schedule” and 
the Scanner configuration profile in the new 
Discovery Configuration, indicating that it refers 
to both deployment and upgrade actions. 

14845 Scanners Solaris SPARCV9 and SPARC32+ binary 
executable files are now recognized when scanned. 

15580 Client Installation The minimum memory requirement for client 
installation has been set to 256 MB. The server 
installation still requires at least 512 MB of RAM 

16634 Find Find is now smarter and does not show the option 
to search on something if there is no data for that 
item.  

17095 Device Manager As part of the new simplified Discovery 
Configuration interface,  profile names,  
virtualization data, and virtualization credentials 
are displayed in the Diagnosis Panel of the Device 
Manager. 

17106 Scanners The hidden version of the Win32 scanner is now 
available when execution needs to be done in a 
completely hidden manner. 

17179 Scanners Detection for Core2, Core2 Quad, and Athlon 64 
FX CPUs has been added. 

17211 Licensing Sending event notification no longer requires the 
Topology license.  

17247 
Help 

The Compatibility Matrix is now available under 
the Help option and is no longer in the Start menu. 

17390 GUI, Documentation The term "Forensic" when referring to scan types 
has been replaced with “Detailed.” 
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Number Location Enhancement Description 

17575 Scanner Generator The “Installed Applications” option has been added 
to the Hardware Data page of the Scanner 
Generator. This was previously available as a 
scanner command line option only. It allows the 
detection of installed applications as registered 
with the operating system to be disabled in the 
Scanner Generator. 

N/A Licensing The port limit has been increased from 100,000 to 
150,000. 

 

Table 3 - Problems Fixed 

Number Location Fix Description 

15852 Configuration and 
Customization 
Guide 

The Scan Command Line correctly uses the “/o” (lower case) 
command line switch. 

16220 Reports The “Unrecognized Files Summary by Scanner Platform” 
report now uses the correct filtering. 

16279 Administration > 
Asset 
Questionnaire 

A blank numeric field is now accepted if it is not a required 
field. 

16685 

 

Migration Guide An explanation has been added to indicate that the hardware 
requirements for the Alarms license are the same as those for 
the Topology license. 

16729 Alarms Viewer In some cases, the exception values in the Alarms Viewer 
were not formatted properly. This problem has been corrected. 

16780 Windows Scanner CTRL-break no longer causes the scanner to crash on exit. 

16785 Installation and 
Initial Setup Guide 

Section added to “Server Installation” chapter explaining how 
to run an unattended installation of Enterprise Discovery by 
using the MSIEXEC command line. 

16804 Administration > 
System 
Configuration, 

Status > Current 
Settings > System 
Configuration 

Items are correctly available with the pertinent license. 

16814 MIB Browser In the Folder tab of the MIB Browser, the Object column now 
sorts properly. 

16825, 16833, 
16843 

MIB Browser MIB Browser no longer has problems with entering data in 
the Variable tab. 
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Number Location Fix Description 

16831 Solaris Scanner One and two-way associative cache support has been added to 
the Solaris scanner. 

16833 MIB Browser In some cases, the Get, Get Next, and Set buttons in the MIB 
Browser would become inadvertently disabled after 
navigating between different items in the tree. This problem 
has been corrected. 

16840  Status > Current 
Settings > Server 
Management 

The “Memory installed” information is now reported correctly 
on servers with more than 4 GB of RAM. 

16853 

 

Administration > 
Account 
Administration 

Values are now saved properly when changing properties of a 
user account. 

16857 Find  Find based on the MAC address now accepts the 
12AB34CD56EF format. Previously, it accepted only the 
12:AB:34:CD:56:EF format. 

16866 Scan Data Viewer On the Hardware tab in the Scan Data Viewer, the up-one-
level icon is properly disabled when at the tree root. 

16876 Event Browser Event Browser returns the community property in a user 
friendly format. This applies to “SNMP Write by MIB OID” 
Events under the “Access Events.” 

16884 Service Analyzer Service Analyzer is simplified when no Alarms license is 
present.  

16893 Viewer The layout for displaying license information has been 
improved. 

16896 Analysis 
Workbench 

Stored files are exported properly from Analysis Workbench. 

16927 Configuration and 
Customization 
Guide 

The file names of the override file on Windows and UNIX/Mac 
OS X systems have been clarified. 

16929 

 

Analysis 
Workbench 

Files with special characters can be taught in Analysis 
Workbench. 

16934 

 

AIX Scanner MAC address detection is now enabled based on the scanner 
configuration. 

16934 UNIX Scanners Error reporting has been improved for various hardware 
detection fields. 

16963 Scanners USB device detection is now enabled based on the scanner 
configuration. 
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Number Location Fix Description 

16970 

 

Solaris Scanner Code page conversion problems have been fixed. Occasionally, 
they caused the scanner to crash. 

17008 Configuration and 
Customization 
Guide 

Confusing references to pager numbers, pager hardware 
setup, etc. from guide and GUI have been removed. 

17028 Status Reports In the Scan File Status report, the filter by unknown retrieval 
date now works correctly. 

17032 Exceptions Devices that are not configured to deploy the agent are now 
excluded from the “Agent Deployment Failed” exception list. 

17060, 17061, 
17062, 17064, 
17069 

Internationalization The Scanner Generator works properly when non-ASCII 
characters are used in various fields. 

17088 Mac OS X Agent Agent upgrade on Mac OS X systems now updates the 
security certificates. 

17100 Status Reports In the “Scan File Status” report, invalid values for the 
RunTimestamp field are now filtered. 

17102 Network Map The Network Map no longer crashes when '&' is in the 
package title. 

17103 Windows Scanners Environment variables are collected properly in Enterprise 
Mode when a user is logged in. 

17137 Network Map The Network Map no longer disconnects when deactivating 
many devices. 

17141 Configuration and 
Customization 
Guide 

Merge priority explanation for the merging logic for 
information collected in the scan files has been clarified in the 
guide. 

17164 SAI Update Wizard SAI missing file data problem after upgrade from ED 2.0 has 
been fixed. 

17200 Analysis 
Workbench 

Access Violation no longer occurs in Analysis Workbench/ SAI 
Editor when teaching applications. 

17202 Viewer The About window now display the correct system memory 
information. 

17203 Database and 
Schema 
Documentation 

SMBIOS table columns now show the proper platforms. 
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Number Location Fix Description 

17207 Find Using the MAC address in the Find tool no longer reports 
duplicate records for devices where the MAC address belongs 
to two ports. 

17209 Migrating from 
Network Discovery 
Guide 

The old MIB variables in SNMP Traps section have been 
updated. 

17210 Discovery Engine The port merging logic has been improved. 

17225 

 

Attribute Manager In the statistics panel of Attribute Manager, the pull-down 
list for the Y-axis now shows all applicable options including 
thresholds. 

17232 Applet Asset Questionnaire command on the aggregate device menu 
can now be accessed correctly. 

17237 Client Installation Unnecessary files have been removed from the Client 
installer. 

17251 Discovery Engine A crash in the Discovery Engine has been fixed. 

17265 Discovery Engine Sometimes the Discovery Engine may not use the appropriate 
SNMP configuration associated with an IP range. 

17275 

 

Network Data 
Analysis Guide 

Information was added to the guide to clarify which menu 
items appear in the Update Model drop-down menu in the 
Device Manager under certain circumstances. 

17301 Element 
Management 

A security exception observed while executing a command 
configured through the element manager has been corrected. 

17305 Windows Scanners In the WMI field extraction, the timeout value is interpreted 
correctly no longer causing the WMI query to fail. 

17306 Windows Scanners A problem causing a system crash on Windows NT 2000 
terminal services has been corrected. 

17340 Planning Guide Direction of port 443 has been clarified in the guide. 

17348 Installation and 
Initial Setup Guide 

A cautionary note has been added to the guide about not 
copying over the ssl.* directories when sharing security 
keys. 

17349 Scanners Environment variables in the file path (text file extract asset 
field) are expanded (implemented for both UNIX and 
Windows) so that scanners can find files. 

17372 

 

Status >  Devices  The "Number of devices" count at the top of these reports have 
been changed to the "Number of exceptions" since the former 
term was misleading. 
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Number Location Fix Description 

17381 Applet Attempts to open remote home or administration pages now 
work correctly. 

17385 Data Migration When upgrading from ED 2.0.x, the Enterprise Discovery 
2.0.x Windows agent can now be used if the server is 
configured to use a hard-coded agent version. 

17391 Scanner Generator Options on the Scanner Options > Troubleshooting tab are 
now correctly reflected in the settings text file. 

17403 Scanner Generator Output properties are retrieved properly when reading the 
configuration containing WMI extract fields back into Scanner 
Generator. 

17426 Scanners The XML parsing problem of scanner parameters is fixed. 
Text in WMI queries containing special characters, such as 
“&”, etc. are no longer truncated. 

17437 UNIX Scanners The problem where, in some cases, directories and file 
information is not collected by the scanner has been fixed. 

17448 Linux Scanner The problem where, in some cases in VMware, MAC address 
information is not collected by the scanner has been fixed. 

17465 Administration > 
Router Discovery 

The java script error when selecting a community string/user 
from the list if there is only one has been fixed. 

17479 Scanners A defect in the collection of SMBIOS port connector 
information has been corrected. 

17485 Applet The “Open Device” menu is now disabled for non-active 
devices. 

17543 Scanners The random delay that can be set when creating a scanner 
now has more variation in its random delay time. 

17563 MIB Browser MIB Browser sessions are no longer dropped when connected 
remotely and left idle for 5 or 10 minutes. 

17564 Network Map When the Network Map session is terminated, the erroneous 
“System Error” dialog is no longer displayed. 

17566 Scheduler Large DB queries no longer cause the Scheduler to pile up 
jobs that will eventually exhaust the DB Connection pool. 

17604 Server The problem where, in some cases, connections were 
incorrectly reported as stale and eventually deleted has been 
corrected. 
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Known Problems, Limitations, and Workarounds 

Agents 

• The agent upgrade process on Solaris 9 may take a long time (SCR# 16663).  

• MAC OS X agent upgrade may not work when initial agent was installed and run from shell (SCR# 
16828).  

Scanners 

• In Manual Deployment Mode, the UNIX scanner will not save offsite scan files to an FTP server when 
the user name is specified in the form domain name/user name (SCR# 12893).  

• Automounts are being scanned in HP-UX and Linux systems (SCR# 15950).  

• The Solaris scanner does not collect Physical Disk Data for Solaris 8 systems (SCR# 16796).  

• Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

• On some Linux distributions, the scanner does not collect Graphics Data (SCR# 17523). 

• When a user is connected to a machine through terminal session, the scanner launched in the manual 
deployment mode gets data related to the session rather than the actual video card data (SCR# 17528). 

• Video card and video memory are not detected properly if the user is logged in to a terminal session 
(SCR# 17528). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (SCR# 15827). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

Server Installation 

• After an uninstall, the branding registry keys are leftover (SCR# 15507).  

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370).  

• Enterprise Discovery with a Network Topology license should not be installed on VMware (SCR# 16524). 

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(SCR# 16520 and SCR# 17016).  

Server 

• If your server has another service using port 80, the HP OpenView Discovery Apache service will not run 
properly (SCR# 14808).  
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• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (SCR# 13964).  

• An older openssl DLLs in the system PATH can affect the Enterprise Discovery Apache server and perl 
engines (SCR# 16318). 

• In some cases, event notifications are generated before the delay interval configured in the event filter 
has passed (SCR# 17271). 

• With the Alarms license only if the configuration option “Number of days to keep imported Discovery 
Database files” (under Administration > System Configuration > Aggregate Configuration) is set to a 
value lower than 10 days, some scheduled tasks will run more frequently than they should and could 
overload the server (SCR# 17459). 

• The VMware discovery user action does not generate an access event and, as a result, the information is 
not reported to the audit log (SCR# 17642). 

Web User Interface 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" option in Discovery Configuration may 
not have any effect (SCR# 14388). 

• First time accessing a screen under Administration > Discovery Configuration might be slow (SCR# 
17312).  

• In the Discovery Configuration, the Subnet IP Type condition should not allow duplication in equivalent 
netmask values (SCR# 17407). 

• In the Discovery Configuration, moving credentials up and down in newly added SNMP and 
Virtualization configuration profiles will not be taken into account. As a workaround, first save the 
profile and then edit it (SCR# 17590). 

• The Device Groups main screen of the Discovery Configuration does not allow sorting by priority (SCR# 
17484).  

• The browser back button loses the correct navigational path when used with the Discovery Configuration 
(SCR# 17491).  

• For a system-defined Virtualization Profile of the Discovery Configuration, the Associated Groups tables 
do not sort (SCR# 17514). 

• In the Discovery Configuration, disabling the "VMware discovery interval" property under the 
Virtualization Configuration Profile is not possible without explicitly entering the value 0 (SCR# 17626). 

Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (SCR# 13803).  

Web Asset Questionnaire 

• The UI may show non-printable characters in text fields (SCR# 16285).  
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Applets 

• Aggregate Find > UpdateModel > Run VMware Discovery can not be disabled when the Device is not 
configured for VMware discovery (SCR# 17502).  

• The Network Map “out of memory” error occurs when continually opening and closing the map window. 
It is necessary to close and reopen the browser to initialize the java plug-in (SCR# 17569). 

• Locate on the Network Map does not highlight the device if the window containing the device is already 
open (SCR# 17617). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (SCR# 16041). 

Internationalization 

• The Scanner Generator cannot be launched when the product is installed in a directory with non-ASCII 
characters in the path (SCR# 17104). 

• Reports do not use the language options configured in the operating system and will always format the 
dates in English (SCR# 17140).  

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (SCR# 17180). 

• NetBIOS information collected by the network models will be displayed incorrectly if the string has non 
ASCII characters (SCR# 17411). 
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